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Overview

Analyses using NSF award data from SharePoint
 Id if i i C d i b l i Identify emerging areas in Career awards using burst analysis
 Evolving geospatial coverage of IGERT awards
 Topical/science coverage of MRI awards
 Co-Investigator network of all 51k NSF awardsg

Topic Analysis using data provided by David Newman
 Topics covered by NSF funding

Alternative Analyses that require additional data
 Flexible network extraction workflows
 Geospatial coding and visualization tools
 Temporal/textual analysis for examining topical trends  
 RefMapper tool for analyzing the interdisciplinarity of grant proposals

This project uses the NSF SciSIP funded Science of Science (Sci2) Tool freely availableThis project uses the NSF SciSIP funded Science of Science (Sci ) Tool freely available 
as open source code and with tutorial at http://sci.slis.indiana.edu/sci2.



Evolving Networks
using NSF award data from SharePoint

Data Provided

All NSF awards that have been active at any time between Oct 2005 and Jan 2010 were provided by 
Paul Markovitz The query was not limited by scientific term program or program officerPaul Markovitz. The query was not limited by scientific term, program or program officer. 

The data was retrieved from the Research Spending and Results (RS&R) service on Research.gov: 
http://www.research.gov/rgov/anonymous.portal?_nfpb=true&_pageLabel=page_research_funding
_search&_nfls=false around Feb 3, 2010 (give or take a day).

The challenge with using RS&R for this purpose is that it is a search-based service, while you want all 
the records. The Excel spreadsheets were created by executing one query to retrieve all the 
information (contained in the spreadsheet columns) from the RS&S database(s) then exporting the 
results to Excel The size of the resulting Excel spreadsheet was too large to upload to the SharePointresults to Excel. The size of the resulting Excel spreadsheet was too large to upload to the SharePoint 
site (I think there is a 50M restriction on file uploads) so I divided the spreadsheet into 3 spreadsheets, 
named

NSF awards Oct 2005_to_June 2007 as of Feb03.xlsx
NSF awards July 2007_to_Sept 2008 as of Feb03.xlsx
NSF awards Oct 2008_to_Jan 2010 as of Feb03.xlsx 

then uploaded them.
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Data Counts and Subsets

 NSF awards starting Oct 2005_to_June 2007 as of Feb03.xlsx (16,762 records) 
 NSF d i J l 2007 S 2008 f F b03 l (18 000) NSF awards starting July 2007_to_Sept 2008 as of Feb03.xlsx (18,000)
 NSF awards starting Oct 2008_to_Jan 2010 as of Feb03.xlsx (16,561 records)

Year Count First Awarded Date Last Awarded Date
2005 831 10/5/2005 12/30/20052005 831 10/5/2005 12/30/2005
2006 10942 1/3/2006 12/29/2006
2007 12031 1/3/2007 12/31/2007
2008 11622 1/2/2008 12/31/2008
2009 15312 1/2/2009 12/31/2009
2010 584 1/4/2010 2/2/2010

Total Count 51322

4 complete years only.

From the 51,322 awards, we deleted 
"test proposals" resulting in 51,217 records. 

We extracted
 IGERT awards (87 records) IGERT awards (87 records)
 Career awards (2409 records) 
 MRI awards (118 records)                                                                                                     
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Data Comparison with NSF Awards Search

Comparing dataset with queries run on NSF’s Award search  
// /

p

(http://www.nsf.gov/awardsearch) on 2010.05.13-14:
 IGERT (87 records) NSFawardsearch retrieves 235 for “IGERT” in title with 

unchecked Historical Awards, Active Awards Only, Expired Awards Only. 
Excluded one research award on the impact of IGERTS. 114 awards start p
before Oct 05, 121 after.

 Career (2409 records) NSFawardsearch retrieves more than 3000 hits for 
active awards that have “career:” in the title. In *Feb03.xlsx there are 30
awards that started before Oct 2005 In the NSFawardsearch result there areawards that started before Oct 2005. In the NSFawardsearch result there are 
512 record that start in 2008 while the *Feb03.xlsx files show 530 records.

 MRI (118 records) NSFawardsearch retrieves 1746 for “MRI” in title with 
unchecked Historical Awards, Active Awards Only, Expired Awards Only.

This data and the subsequent analyses should not be used for decision 
making before the accuracy of the data is confirmed.
SharePoint data is used subsequentlySharePoint data is used subsequently.
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Data Fields Comparison

NSF’s Awards Search

** Dollar amount

*Feb03.xlsx provided via Sharepoint   
Award Number
Title
NSF Organization
Program(s)
Start Date
Last Amendment Date

p p
AWARDEE
DOING_BUSINESS_AS_NAME
PI_NAME
COPI
PI_PHONE, PI_EMAIL
AWARD DATELast Amendment Date

Principal Investigator
State
Organization
Award Instrument
Program Manager
Expiration Date

AWARD_DATE
ESTIMATED_TOTAL_AWARD_AMOUNT
FUNDS_OBLIGATED_TO_DATE**
AWARD_START_DATE
AWARD_EXPIRATION_DATE
TRANSACTION_TYPE
AGENCYExpiration Date

Awarded Amount to Date**
Co-PI Name(s)
PI Email Address
Organization Street Address 
Organization City
O i i S

AGENCY
CFDA_NUMBER
PRIMARY_PROGRAM_SOURCE
AWARD_TITLE_OR_DESCRIPTION
FEDERAL_AWARD_ID_NUMBER
DUNS_ID, PARENT_DUNS_ID
PROGRAM NAMEOrganization State

Organization Zip
Organization Phone
NSF Directorate
Program Element Code(s)
Program Reference Code(s)

PROGRAM_NAME
PROGRAM_OFFICER_NAME, PROGRAM_OFFICER_PHONE, PROGRAM_OFFICER_EMAIL
AWARDEE_STREET_1, AWARDEE_STREET_2, AWARDEE_CITY, AWARDEE_STATE, 

AWARDEE_ZIP, AWARDEE_COUNTY, AWARDEE_COUNTRY, 
AWARDEE_CONG_DISTRICT

PERFORMING_ORG_NAME
PERFORMING STREET 1 PERFORMING STREET 2 PERFORMING CITYField Of Application(s)

Award Number
Abstract
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PERFORMING_STREET_1, PERFORMING_STREET_2, PERFORMING_CITY, 
PERFORMING_STATE, PERFORMING_ZIP, PERFORMING_COUNTY, 
PERFORMING_COUNTRY, PERFORMING_CONG_DISTRICT

ABSTRACT_AT_TIME_OF_AWARD

Type of Analysis vs. Scale of Level of Analysisyp y y

Micro/Individual
(1 100 d )

Meso/Local
(101 10 000 d )

Macro/Global
(10 000 d )(1-100 records) (101–10,000 records) (10,000 < records) 

Statistical 
Analysis/Profiling 

Individual person and 
their expertise profiles

Larger labs, centers, 
universities, research 
domains, or states

All of NSF, all of USA, 
all of science.

,

Temporal Analysis 
(When)

Funding portfolio of 
one individual

Mapping topic bursts 
in 20-years of PNAS

113 Years of physics 
Research

Geospatial Analysis 
(Where)

Career trajectory of one 
individual  

Mapping a states 
intellectual landscape

PNAS publications 

Topical Analysis Base knowledge from Knowledge flows in VxOrd/Topic maps ofTopical Analysis 
(What)

Base knowledge from 
which one grant draws.

Knowledge flows in 
Chemistry research 

VxOrd/Topic maps of 
NIH funding

Network Analysis 
(With Whom?)

NSF Co-PI network of 
one individual

Co-author network NSF’s core competency 
(With Whom?) one individual  
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Temporal Analysis (When)
Bursty terms in titles of Career awards

Burst Analysis using Kleinberg’s algorithm.

Results are visualized using Horizontal Bar Graph

Area size equals numerical 
value e.g. burst strength

Start date End date

value, e.g., burst strength

Text, e.g., title

Terms that are still bursty are not shown.

2005      2006    2007     2008

Temporal Analysis (When)
Bursty terms in titles of Career awards

Burst Analysis using Kleinberg’s algorithm.

Results are visualized using Horizontal Bar Graph

Area size equals numerical 
value e.g. burst strength

Start date End date

value, e.g., burst strength

Text, e.g., title

Terms that are still bursty are not shown.

2005      2006    2007     2008



Geospatial Analysis (Where)
E l i G i l C f IGERT A dEvolving Geospatial Coverage of IGERT Awards

IGERT award data was aggregated by state and overlaid on geomap.

Ci l i d d b l d ll d l d b # d dCircles are size coded by total dollar amount and colored by # awards made.

2006
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Geospatial Visualizations (IGERT 2006)
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Geospatial Visualizations (IGERT 2006-2007)
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Geospatial Visualizations (IGERT 2006-2008)
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Geospatial Visualizations (IGERT 2006-2009)
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Note that circle sizes differ across time slices.

Topical Analysis (What)
UCSD Map of Science overlay of 118 MRI awards 

The UCSD Map of Science was generated based on 7.2 million papers published 
in over 16,000 separate journals, proceedings, and series from Thomson Scientific 
and Scopus over the five year period from 2001 to 2005. Papers and journals were 
grouped into 554 clusters of highly related journals. The links between the 
l h h l l d h l b i h lclusters show that some clusters are related to other clusters but are not as tightly 

connected as the journals that make up each cluster. 

Each cluster is labeled both by the content area shared by the journals in the 
l d b h l dcluster and by the colored

overarching scientific 

domain for that cluster.

Data is science located 

by matching journal names 

or keywords associatedor keywords associated 

with each of the 554 clusters.



Topical Analysis (What)

Newman’s terms were matched to keywords associated with the 554 clusters.

UCSD Map of Science overlay of 118 MRI awards 

See Borner-Zoss-MRI-Scimap.pdf file.

Network Analysis (With Whom?)
C PI N k f ll 51 217 NSF d dCo-PI Network of all 51,217 NSF award records

The co-PI network for all 51,217 
NSF award records was extractedNSF award records was extracted. 
There are about 50,000 unique 
investigator names grouped in over 
20,000 components (unconnected 
networks)networks).  
The largest (giant) component has 
more than 10,000 investigators and 
is shown here.
Nodes were size coded by fundingNodes were size coded by funding 
amount—equally split among the 
investigators. That is, if there were 
5 PIs on an award, each received 
1/5 of the amount of the total 
award amount.
Investigator nodes are connected if 
they co-occurred on one award.

Disclaimer: Four years are very 
little time to grow networks.
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Giant component of 

co-investigator network 

(top left)(top left)

Zoom (lower right)

TTopic Analysis
using data provided by David Newman



Topic Data provided by David Newman, UCI on May 15, 2010 

Topic model (also known as Latent Dirichlet Allocation) is an unsupervised statistical 

http://www.ics.uci.edu/~newman/nsf/may15/

algorithm for modeling document collections.

Procedure:
1 A b f d t ti t d f th 51k d f th th l fil1. A bag-of-words representation was created from the 51k awards from the three xls files 

on the Sharepoint site by taking all the text in the title and abstract.  Simple tokenization 
was performed, and stop words and infrequent terms were deleted.

2. A topic model was learned using T=400 topics (Gibbs sampler run for 800 iterations 
using const symmetric Dirichlet priors of beta=0.01 and alpha=0.05*N/(D*T))

3. Two results files were produced: 
• prelim.topics.newman.txt (400 lines) contains a list of top-8 words in each of 400 topics 

learned by topic modellearned by topic model.
• prelim.nsfid.top.topics.newman.txt comprises a list of up to top-four topics in each award 

abstract. Topics accounting for < 10% of document were suppressed. There are only 
50,608 lines as some awards had had no clear topic tags.

21

Complete term network with 3 components (top left)

1,592 term nodes and 10,389 co-occurrence edges.

Nodes with degree >= 50 are given in red and are labeled.g g



Complete term network with 3 components (top left)

1,592 term nodes and 10,389 co-occurrence edges.

Nodes with degree >= 50 are given in red and are labeled.g g

Zoom (lower right)

Reducing edges via
MST-Pathfinder 
Network ScalingNetwork Scaling
Input Parameters:

Result:
1,592 nodes and 8,560 
edges.

Three components are 
shown in middle.
Nodes with degree > 7 
are red and labeled.

Zoom into small 
components are shown 
to the right.
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Alternative Analyses 
that require additional data

Sci2 Tool for Science of Science 
Research and Practice  
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Sci2 Tool: Algorithms 
See https://nwb.slis.indiana.edu/community

Preprocessing
Extract Top N% Records
Extract Top N Records
Normalize Text

Modeling
Random Graph
Watts-Strogatz 
Small World

Weighted & Undirected
Clustering Coefficient
Nearest Neighbor Degree
Strength vs Degree

Slice Table by Line
---------------------------------------------
Extract Top Nodes
Extract Nodes Above or Below Value
Delete Isolates

Barabási-Albert Scale-Free
TARL

Analysis
Network Analysis Toolkit (NAT)

g g
Degree & Strength
Average Weight vs End-point Degree
Strength Distribution
Weight Distribution
Randomize Weights

---------------------------------------------
Extract top Edges
Extract Edges Above or Below Value
Remove Self Loops
Trim by Degree
MST Pathfinder Network Scaling

Unweighted & Undirected
Node Degree
Degree Distribution
---------------------------------------------
K-Nearest Neighbor (Java)
Watts Strogatz Clustering Coefficient

---------------------------------------------
Blondel Community Detection
---------------------------------------------
HITS

Unweighted & Directed
Node IndegreeMST-Pathfinder Network Scaling

Fast Pathfinder Network Scaling
---------------------------------------------
Snowball Sampling (in nodes)
Node Sampling
Edge Sampling

Watts-Strogatz Clustering Coefficient
Watts Strogatz Clustering Coefficient over K
---------------------------------------------
Diameter
Average Shortest Path
Shortest Path Distribution

Node Indegree
Node Outdegree
Indegree Distribution
Outdegree Distribution
---------------------------------------------
K-Nearest Neighborg p g

---------------------------------------------
Symmetrize
Dichotomize
Multipartite Joining
---------------------------------------------
G d

Node Betweenness Centrality
---------------------------------------------
Weak Component Clustering
Global Connected Components
---------------------------------------------

C

Single Node in-Out Degree Correlations
---------------------------------------------
Dyad Reciprocity
Arc Reciprocity
Adjacency Transitivity
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Geocoder
---------------------------------------------
Extract ZIP Code

Extract K-Core
Annotate K-Coreness
---------------------------------------------
HITS

---------------------------------------------
Weak Component Clustering
Strong Component Clustering
---------------------------------------------

Sci2 Tool: Algorithms cont.
See https://nwb.slis.indiana.edu/community

--------------------------------

Extract K-Core

Annotate K Coreness

Visualization
GnuPlot
GUESS

Scientometrics
Remove ISI Duplicate Records
Remove Rows with Multitudinous FieldsAnnotate K-Coreness

--------------------------------

HITS

PageRank

Weighted & Directed

Image Viewer
---------------------------------------------
Radial Tree/Graph (prefuse alpha)
Radial Tree/Graph with Annotation 

(prefuse beta)
T Vi ( f b )

Detect Duplicate Nodes
Update Network by Merging Nodes
---------------------------------------------
Extract Directed Network
Extract Paper Citation Network
E A h P N kHITS

Weighted PageRank

Textual

Burst Detection

Tree View (prefuse beta)
Tree Map (prefuse beta)
Force Directed with Annotation 

(prefuse beta)
Fruchterman-Reingold with Annotation 

(prefuse beta)

Extract Author Paper Network
---------------------------------------------
Extract Co-Occurrence Network
Extract Word Co-Occurrence Network
Extract Co-Author Network
Extract Reference Co-OccurrenceBurst Detection (prefuse beta)

---------------------------------------------
DrL  (VxOrd)
Specified (prefuse beta)
---------------------------------------------
Horizontal Line Graph

Extract Reference Co Occurrence 
(Bibliographic Coupling) Network

---------------------------------------------
Extract Document Co-Citation Network

Circular Hierarchy
Geo Map (Circle Annotation Style)
Geo Map (Colored-Region Annotation Style)
*Science Map (Circle Annotation)
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* Requires permission from UCSD              General Network extraction
All four+ save into Postscript files.



Network Extraction

Sample paper network (left) and four different network types derived from it (right).
From ISI files, about 30 different networks can be extracted.,

29

Sci2 Tool

Plugins that render into Postscript files:

Sci Maps
Geo Maps

Horizontal Time Graphs

Börner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Duhon, Russell Jackson, Phillips, Patrick, Ma, 
Nianli, Zoss, Angela,  Guo, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and 
Visualizing Scholarly Networks Using the Scholarly Database and the Network Workbench Tool. 
Proceedings of ISSI 2009: 12th International Conference on Scientometrics and Informetrics, Rio de Janeiro, 
Brazil, July 14-17 . Vol. 2, pp. 619-630. 
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Funding Data Analysis
Free online services such as NSF’s Award Search (See Section 4.2.2.1 NSF Award 
Search) support the retrieval of  ego-centric funding profiles. Here, a search was 
exemplarily conducted for “Katy Borner” in the “Principal Investigator” field while 
keeping the “Include CO-PI” box checked.

The resulting data is available at 
‘*yoursci2directory*/sampledata/scientometrics/nsf/KatyBorner.nsf.’ Load the data using ‘File 
> Load’ select the loaded dataset in the Data Manager window and run ‘Data> Load , select the loaded dataset in the Data Manager window, and run Data 
Preparation > Text Files > Extract Co-Occurrence Network’ using these parameters:
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Select the “Extracted Network on Column All Investigators” network and run ‘Analysis 
>Networks > Network Analysis Toolkit (NAT)’ to reveal that there are 13 nodes and 28 
edges in the network without isolates. Select ‘Visualization > Networks > GUESS’ to 
visualize the resulting Co-PI network. Select ‘GEM’ from the layout menu.

Load the default Co-PI visualization theme via ‘File > Run Script …’ and load 
‘*yoursci2directory*/scripts/GUESS/co-PI-nw.py’.  Alternatively, use the “Graph Modifier” 
to customize the visualization. The resulting network in Figure 5.2 was modified 
using the following workflow:
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Co-PI Network
This is a so called 

ego-centric network, 

i.e., almost complete 

data is available and 

shown for exactly 

one ego. The funding 

records for all other 

people in the network 

are most likely

incomplete.incomplete.
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Award Durations and Totals

For a summary of  the grants themselves, with a visual representation of  their award y g , p
amount, select the NSF csv file in the Data Manager and run ‘Visualization > Temporal 
> Horizontal Bar Graph’, entering the following parameters:

The generated postscript file can be viewed using Adobe Distiller or GhostViewer 
(see Section 2.4 Saving Visualizations for Publication).
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Award Durations and Totals

A i l i l

St t d t E d d t

Area size equals numerical 
value, e.g., award amount.

Text, e.g., title

Start date End date
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Replicate Studies Using Database Support

Load ‘*yoursci2directory*/sampledata/scientometrics/isi/FourNetSciResearchers.isi’, using y y / p / / / , g
‘File > Load’ instead of  ‘File > Load and Clean ISI File’.  

Run ‘File > Load Into Database > Load ISI File Into Database’.  View the database 
schema by right-clicking on the loaded database in the Data Manager and clicking y g g g g
“View”.
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Replicate Studies Using Database Support – Unification

Run ‘Data Preparation > Database > ISI > Merge Identical ISI People’, followed by ‘Data p g p , y
Preparation > Database > ISI > Merge Journals’ and ‘Data Preparation > Database > ISI > 
Match References to Papers’.  Make sure to wait until each cleaning step is complete 
before beginning the next one. Read red warnings.
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Extract Basic Properties

Run ‘Data Preparation > Database > ISI > Extract Authors’ and right-click on the p g
resulting table to view all the authors from FourNetSciResearchers.isi.  The table also 
has columns with information on how many papers each person in the dataset 
authored, their Global Citation Count (how many times they have been cited 
according to ISI), and their Local Citation Count (how many times they were cited in 
the current dataset).
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Records over time
Aggregate data by year by running ‘Data Preparation > Database > ISI > Extract Authors > gg g y y y g p
Extract Longitudinal Study.’ Result is a table which lists metrics for every year mentioned in the 
dataset.  The longitudinal study table contains the volume of  documents and references 
published per year, as well as the total amount of  references made, the amount of  distinct 
references distinct authors distinct sources and distinct keywords per yearreferences, distinct authors, distinct sources, and distinct keywords per year.  
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Records over time
Aggregate data by year by running ‘Data Preparation > Database > ISI > Extract Authors > gg g y y y g p
Extract Longitudinal Study.’ Result is a table which lists metrics for every year mentioned in the 
dataset.  The longitudinal study table contains the volume of  documents and references 
published per year, as well as the total amount of  references made, the amount of  distinct 
references distinct authors distinct sources and distinct keywords per yearreferences, distinct authors, distinct sources, and distinct keywords per year.  
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Burst Analysis for References

The queries can also output data specifically tailored for the burst detection q p p y
algorithm (see Section 4.6.1 Burst Detection).  Run ‘Data Preparation > Database > 
ISI > Extract Authors > Extract References by Year for Burst Detection’ on the cleaned 
database followed by ‘Analysis > Topical > Burst Detection’ with parameters on left and 
then run ‘Visualize > Temporal > Horizontal Bar Graph’ with parameters on right.

Watch those red warnings!
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Open HBG4NetSci.pdf
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Burst Analysis Result

early bursts
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early bursts

Topic Mapping: UCSD Science Map

JournalsScienceMap-FourNetSciResearchers.pdf
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

What organizations and programs at the National Science Foundation support 
projects that deal with medical and health related topics? Data was downloaded from 
the NSF Awards Search SIRE (http://www.nsf.gov/awardsearch) on Nov 23rd, 2009, 
using the query “medical AND health” in the title, abstract, and awards field, with 
“Active awards only” checked (see section 4.2.2.1  NSF Award Search for data 
retrieval details).
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Using NSF Awards Search:
http://www.nsf.gov/awardsearch
download relevant NSF awards that 
have “medical” AND “health”
i i l b d din title, abstract, and awards.
Active awards only. 

Number of awards: 283 awardsNumber of  awards: 283 awards
Total awarded amount to date: 
$152,015,288 

Retrieved on Oct 18, 2009
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Horizontal Bargraph

Area size equals numerical 
value, e.g., award amount.

Start date End date

Text, e.g., title

Top-10 grants with highest $Awarded to Date:Top 10 grants with highest $Awarded to Date:
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Horizontal Bargraph
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Bimodal Network of  NSF Organization to Program(s)

Extract Directed Network was selected.
Source Column: NSF Organization
Text Delimiter: |
Target Column: Program(s)

Nodes: 167Nodes: 167
Isolated nodes: 0
Edges: 177
No parallel edges were discovered.
Did not detect any edge attributes
This network does not seem to be a valued network.
Density (disregarding weights): 0.00638
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Measuring (Input/Output) Interdisciplinarity  

Can be measured based on

 Title, abstract or full proposal text 

Can be visualized as 

 Tables with cluster assignments.
using simple text analysis or 
linguistic techniques. Difficult across 
disciplinary boundaries as writing styles 

d d diff

 TopicMaps—visual groupings of  
awards that are similar.

 Science Map overlays, see below 
and word usage are very different.

 Proposal references (cited base 
knowledge) using RefMapper.

p y ,
and next slide.

 Keywords provided by investigators, 
e.g., for CDI proposals.

 Background/departments/publications
/prior funding of  PI/Co-PIs—
requires unique people IDs and resume 
like information. VIVO might help 
h (h // i b )here (http://vivoweb.org).

 Publications and other results reported 
in NSF progress reports. 
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Duhon & Börner forthcoming

Reference Mapper

Duhon & Börner, forthcoming.
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http://sci.slis.indiana.edu
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CIs Developed and Served by CNS

Scholarly Database: 23 million scholarly records
http://sdb.slis.indiana.edu

Information Visualization Cyberinfrastructure
http://iv.slis.indiana.edu

Network Workbench Tool + Community Wiki
http://nwb.slis.indiana.edu

Sci2 Tool and Science of Science CI Portal
http://sci.slis.indiana.edu

Epidemics Cyberinfrastructure
http://epic.slis.indiana.edu/
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All papers, maps, cyberinfrastructures, talks, press are linked 
from http://cns.slis.indiana.edu
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